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RESOLUCION No. O 1 4 4 12 ABR 2021

Por el cual se adopta la metodologia para Identificacién y Delimitacion de Areas de
Importancia Estratégica para el Recurso Hidrico dentro de la jurisdiccion de CORPOCESAR

El Director General de la Corporacién Auténoma Regional del Cesar -CORPOCESAR-, en egjercicio
de sus facultades legales y estatutarias y en especial de las que le confieren la Ley 99 de 1993, el
Decreto 2811 de 1974, y el Acuerdo 001 del 31 de marzo de 2005, aprobado por la Resolucion 1308
del 12 de septiembre de 2005 del Ministerio de Ambiente, Vivienda y Desarrollo Territorial, por el cual
se aprueban los Estatutos de la Corporaciéon Auténoma Regional del Cesar -CORPOCESAR- v el
1993 y el decreto 1076 del 26 de mayo de 2015y,

CONSIDERANDO

Que los articulos 8 y 79 de la Constitucion Politica de Colombia consagran como obligacién del
Estado y de las personas proteger las riquezas culturales y naturales de la Nacion.

Que el articulo 70 Ibidem, elevé a rango constitucional la obligacion del Estado de proteger el
ambiente y el derecho que tienen todos los ciudadanos al goce de un ambiente sano. Asi mismo
establece que es deber del Estado proteger la diversidad e integridad del ambiente, conservar las
areas de especial importancia ecologica y fomentar la educacién para el logro de estos fines.

Que el articulo 95 (numeral8) de la constitucion Politica, consagra el deber de toda persona de
proteger los recursos culturales y naturales del ‘pais, y velar por la conservacidon de un ambiente
sano.

Que el articulo 58 de la Constitucién Politica de Colombia, establece que “se garantizan la propiedad
privada y los demas derechos adquiridos con arreglo a las leyes civiles, los cuales no pueden ser
desconocidos ni vulnerados por leyes posteriores. Cuando de la aplicacién de una ley expedida por
motivos de utilidad publica o interés social, resultaren en conflicto los derechos de los particulares
con la necesidad por ella reconocida, el interés privado debera ceder al interés publico o social. La
propiedad es una funcion social que implica obligaciones. Como tal, le es inherente una funcion
ecoldgica...”

Que el articulo 80 de la Constitucién Politica de Colombia consagra como deber del Estado planificar
el manejo y aprovechamiento de los recursos naturales para garantizar el desarrollo Sostenible, su
conservacion, restauracion o sustitucién y tomar las medidas necesarias de prevencién y control de
los factores de deterioro ambiental.

Que corresponde a esta Corporacion ejercer la funciéon de autoridad ambiental dentro del area de
Jurisdiccion, de conformidad con lo establecido en el numeral 2 del articulo 31 de la Ley 99 de 1993.

Que en virtud del numeral 9 del articulo 31 de Ley 99 de 1993, corresponde a la CORPORACION
AUTONOMA REGIONAL DEL CESAR — CORPOCESAR, otorgar concesiones, permisos,
autorizaciones y licencias ambientales requeridas por la ley para el uso aprovechamiento o
movilizacion de los recursos naturales renovables o para el desarrollo de actividades que afecten o
\puedan afectar el medio ambiente. Otorgar permisos y concesiones para aprovechamientos
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forestales, concesiones para el uso de aguas superficiales y subterraneas y establecer vedas para la
caza y pesca deportiva

Que el numeral 12 del articulo 31 de la Ley de 1993, establece que las Corporaciones Auténomas
Regionales, ejercen las funciones de evaluacién control y seguimiento ambiental de los usos del
agua, el suelo, el aire y los demas recursos naturales renovables, lo cual comprendera el vertimiento,
emision, incorporacion de sustancias o residuos liquidos, sélidos y gaseosos a las aguas en
cualquiera de sus formas, al aire a los suelos asi como los vertimientos o emisiones que puedan
causar dafio o poner en peligro el normal desarrollo sostenible de los recursos naturales renovables,
impedir, obstaculizar su empleo para otros usos

Que en el articulo 108 de la Ley 99 de 1993 modificado por el articulo 174 de la Ley 1753 de 2015
preve que las autoridades ambientales en coordinacion y con el apoyo de las entidades territoriales
adelantaran los planes de cofinanciacion necesarios para adquirir areas o ecosistemas estratégicos
para la conservacion, preservacion, y recuperacion de los recursos naturales o implementaran en
ellas esquemas de pago por servicios ambientales u otros incentivos econémicos para la
conservacion, con base en la reglamentacion expedida por el Gobierno Nacional.

La definicion de estas areas y los procesos de adquisicion, conservacién y administracion deberan
hacerse con la activa participacion de la sociedad civil.

Que en el paragrafo 1° del referido articulo establece que los esquemas de pago por servicios
ambientales de que trata el presente articulo, ademas podran ser financiados con recursos
provenientes de los articulos 43 y 45 de la Ley 99 de 1983, de conformidad con el plan de
ordenacion y manejo de la cuenca respectiva. Asi mismo, podra aplicarse la inversion forzosa de que
trata paragrafo 10 del articulo 43, las compensaciones por pérdida de biodiversidad en el marco de Ia
licencia ambiental y el Certificado de Incentivo Forestal con fines de conservacién que se referencia
el paragrafo del articulo 253 del Estatuto Tributario.

Que en el articulo 111 de la Ley 99 de 1993 modificado por el articulo 210 de la Ley 1450 de 2011,
se establece declarar de interés publico las areas de importancia estratégica para la conservacion de
recursos hidricos que surten de agua los acueductos municipales, distritales y regionales.

Los departamentos y municipios dedicaran un porcentaje no inferior al 1% de sus ingresos corrientes
para la adquisicion y mantenimiento de dichas zonas o para financiar esquemas de pago por
servicios ambientales.

Los recursos de que trata el presente articulo, se destinaran prioritariamente a la adquisicion y
mantenimiento de las zonas.

Las autoridades ambientales definiran las areas prioritarias a ser adquiridas con estos recursos o
donde se deben implementar los esquemas de pagos por servicios ambientales de acuerdo con la
reglamentacion que el Ministerio de Ambiente, Vivienda y Desarrollo Territorial expida para el efecto.

Q\SU administracion corresponderd al respectivo distrito o municipio. Los municipios, distritos y
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departamentos garantizarén la inclusién de los recursos dentro de sus planes de desarrollo y
presupuestos anuales correspondientes, individualizandose la partida destinada para tal fin.

Que en el paragrafo 2° del precitado articulo se dispone que el Ministerio de Ambiente, Vivienda y
Desarrollo Territorial, Institutos de Investigacion Cientifica adscritos y vinculados, las Corporaciones
Autonomas Regionales y de Desarrollo Sostenible, las Autoridades Ambientales de los Grandes
Centros Urbanos y los establecimientos ambientales a que se refiere el articulo 13 de la Ley 768 de
2002, podran en el marco de sus competencias, efectuar los aportes técnico financieros y operativos
requeridos para la consolidacion del instrumento de pago por servicios ambientales vy el desarrolio de
proyectos derivados de este instrumento.

Que el articulo 2 de la Ley 23 de 1973, establece que el medio ambiente es un patrimonio comdn:
por lo tanto, su mejoramiento y conservacion son actividades de utilidad publica, en Ia gue deberan
participar el Estado y los particulares. Y el mismo, define que el medio ambiente estd constituido por
la atmésfera y los recursos naturales renovables

Que el Codigo Nacional de Recursos Naturales Renovables y de Proteccién al Medio Ambiente
(Decreto-Ley 2811 de 1974) consagra en su articulo 1% Que el ambiente es patrimonio coman y que
el Estado y los particulares deben participar en su preservacion y manejo, por ser de utilidad publica
e interés social. La preservaciéon y manejo de los recursos naturales renovables también son de
utilidad publica e interés social

Que el articulo 9 establece que el uso de elementos ambientales y de recursos naturales renovables.
debe hacerse de acuerdo con los siguientes principios:

a) Los recursos naturales y demas elementos ambientales deben ser utilizados en forma eficiente, para
lograr su maximo aprovechamiento con arreglo al interés general de la comunidad y de acuerdo con
los principios y objetos que orientan este Codigo;

b) Los recursos naturales y demas elementos ambientales, son interdependientes. Su utilizacion se hara
de manera que, en cuanto sea posible, no interfieran entre si.

c) La utilizacién de los elementos ambientales o de los recursos naturales renovables debe hacerse sin
que lesione el interés general de la comunidad o el derecho de terceros;

d) Los diversos usos que pueda tener un recurso natural estardn sujetos a las prioridades que se
determinen y deben ser realizados coordinadamente para que se puedan cumplir los principios
enunciados en los ordinales precedentes.

e) Los recursos naturales renovables no se podran utilizar por encima de los limites permisibles que, al
alterar las cualidades fisicas, quimicas o biolégicas naturales produzcan el agotamiento o el deterioro
grave de esos recursos o se perturbe el derecho a ulterior utilizacion en cuanto ésta convenga al
interés publico.

f) La planeacion del manejo de los recursos naturales renovables y de los elementos ambientales debe
hacerse son forma integral, de tal modo que contribuya al desarrollo equilibrado urbano y rural. Para
bienestar de la comunidad, se estableceran y conservaran en los centros urbanos y sus alrededores
espacios cubiertos de vegetacion.

Que el articulo 42 del decreto 2811 de 1974, establece que pertenecen a la nacién los recursos
naturales renovables y demas elementos ambientales regulados por dicha norma, que se encuentren
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dentro del territorio Nacional, sin perjuicio de los derechos legitimamente adquiridos por particulares
y de las demas normas especiales sobre baldios.

Que asi mismo, el articulo 47 del cddigo de los recursos naturales, sefiala qgue sin perjuicio de los
derechos adquiridos por terceros o de las normas especiales de dicho ordenamiento, podra
declararse reservada una porcion determinada o la totalidad de los recursos naturales renovables de
una regidn o zona preservacion de esos recursos, o cuando el estado resuelva explotarlos.

Que en el articulo 4 del Decreto 953 de 2013 se indicd que para efectos de Ia adquisicidon de predios
o la implementacién de esquemas de pago por servicios ambientales por parte de las entidades
territoriales, las autoridades ambientales deberan previamente identificar. delimitar y priorizar las
areas de importancia estratégica, con base en la informacién contenida en los planes de ordenacion
y manejo de cuencas hidrogréficas, planes de manejo ambiental de microcuencas. planes de manejo
ambiental de acuiferos o en otros Instrumentos de planificacién ambiental relacionados con el
recurso hidricos.

En ausencia de los instrumentos de planificacion de que trata el presente articulo cuando en estos
no se hayan identificado. delimitado v priorizado las areas de importancia estratégica, la entidad
territorial deberd solicitar a la autoridad ambiental competente que |dentifique, delimite v priorice
dichas areas.

Que en el articulo 5 ibidem se establece que las entidades territoriales con el apoyo técnico de la
autoridad ambiental de su jurisdiccion, deberan seleccionar al interior de las reas de importancia
estratégica identificadas, delimitadas y priorizadas por la autoridad ambiental competente, los
predios a adquirir, a mantener o a favorecer con el pago por servicios ambientales, y que para la
seleccion de los predios se deben evaluar los siguientes criterios, sin perjuicio de otros adicionales
que podra definir mediante acto administrativo el Ministerio de Ambiente y Desarrollo Sostenible:

1. Poblacién abastecida por los acueductos beneficiados con la conservacién del area estratégica dentro
de la cual esta ubicado el predio.

Presencia en el predio de corrientes hidricas, manantiales, afloramientos y humedales.

Importancia del precio en la recarga de acuiferos o suministro hidrico.

Proporcion de coberturas y ecosistemas naturales poco o nada intervenidos presentes en el predio.
Grado de amenaza de los ecosistemas naturales por presion antropica.

Fragilidad de los ecosistemas naturales existentes.

Conectividad ecosistémica.

Incidencia del predio en la calidad del agua que reciben los acueductos beneficiados.

OND G AN

Que en el articulo 8 se preceptla que las entidades territoriales deberan invertir prioritariamente los
recursos de que trata el presente decreto en la adquisicién y mantenimiento de los predios
localizados en las areas de importancia estratégica. El incentivo de pago por servicios ambientales
aplicara transitoriamente mientras la entidad territorial adquiere el respectivo predio localizado en
dichas areas.

|
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Que el articulo 2.2.9.8.1.1 del Decreto 1076 del 28 de mayo de 2015 prevé que ese capitulo tiene por
objeto reglamentar el incentivo de pago por servicios ambientales, de conformidad con lo establecido
en el Decreto Ley 870 de 2017.

Ilgualmente, se implementa lo referente a pago por servicios ambientales y la adquisicién y
mantenimiento de predios en areas y ecosistemas estratégicos que tratan los articulos 108 y 111 de
Ley 99 de 1993, modificados por los articulos 174 de la Ley 1753 de 2015 y 210 de la Ley 1450 de
2011, respectivamente.

Que el articulo 2.2.9.8.2.2 ibidem establece que, las modalidades de pagos por servicios ambientales
se refieren a un servicio ambiental que se busca mantener o generar mediante dicho pago.

De conformidad con lo dispuesto en literal b del articulo 7 del Decreto Ley 870 de 2017, dentro de
las modalidades de pago por servicios ambientales que podrian implementarse se destaca Ia
modalidad de Pago por servicios ambientales de regulacion y calidad hidrica que corresponde al
pago por los servicios ambientales asociados al recurso hidrico que permiten el abastecimiento del
agua en términos de cantidad o calidad, para satisfacer prioritariamente el consumo humano, e
igualmente, otros usos como el agropecuario, la generacién de energia, uso industrial y el
mantenimiento de procesos ecosistémicos.

Esta modalidad de pago por servicios ambientales hidricos se orientara prioritariamente a areas o
ecosistemas estratégicos y predios con nacimientos y cuerpos de agua, o en zonas de recarga de
acuiferos, que surten de agua fuentes abastecedoras especialmente de acueductos municipales,
distritales y regionales, y distritos de riego; igualmente, las zonas de importancia para la regulacién y
amortiguacion de procesos y fenémenos hidrometeorolégicos y geoldgicos extremos con incidencia
en desastres naturales.

Que el articulo 2.2.9.8.4.1 ibidem instituy6 que, los municipios, distritos vy departamentos efectuaran
las inversiones con el porcentaje no inferior al 1 % de los ingresos corrientes establecido por el
articulo 111 de la ley 99 de 1993, modificado por el articulo 210 de la Ley 1450 de 2011, con
sujecion a lo previsto en el presente capitulo.

Igualmente, las autoridades ambientales en coordinacién y con el apoyo de las entidades territoriales
realizaran las inversiones de que trata el articulo 108 de Ley 99 de 1993, modificado por el articulo
174 de la Ley 1753 de 2015, en el marco de lo establecido en el presente capitulo.

Que el articulo 2.2.9.8.4.2 ibidem dispone que el procedimiento para la adquisicion de predios se
regira por lo establecido en la Ley 388 de 1997 o la norma que lo modifique, adicione, sustituya o
complemente.

La adquisicion de predios por parte de los proyectos de construccion y operacién de distritos de riego
no sujetos a licencia ambiental de que trata el articulo 111 de la Ley 99 de 1993, se efectuara en las
areas y ecosistemas estratégicos para la conservacion de los recursos hidricos que los surten de
agua, determinados por las autoridades ambientales competentes.
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El mantenimiento de predios se refiere a aquellas actividades directamente desarrolladas en los
predios adquiridos por las entidades territoriales para la preservacién y restauracién de los
ecosistemas presentes en los mismos, para lo cual la autoridad ambiental competente dara el apoyo
técnico requerido por la entidad territorial.

Que la Subdireccion General del drea de Gestion Ambiental emite concepto de adopcién con una
metodologia para la identificacién, delimitacion y priorizacién de las areas de importancia estratégica,
la cual integrara la informacién cartografica existente en la Corporacién como planes de ordenacién y
manejo de cuencas hidrograficas, planes de manejo ambiental de acuiferos, y otros instrumentos de
planificacion ambiental relacionados con el recurso hidrico.

Que en consecuencia y en aras de brindar una herramienta efectiva a los Entes Territoriales de la
jurisdiccion para la materializacion de lo previsto en el articulo 111 de la Ley 99 de 1993 y los
articulos 2.2.9.8.1.1 y subsiguientes del Decreto 1076 del 26 de mayo de 2015, parz la adquisicién
de predios o la implementacién de pago por servicios ambientales, se acogera lo preceptuado en &l
citado concepto y, por ende, el mismo hara parte integral del presente acto administrativo.

Que, como consecuencia de lo anteriormente referenciado, el Director General de la Corporacién
Auténoma Regional del Cesar - CORPOCESAR, adoptaré la metodologia para la identificacion y
delimitacion de 4areas de importancia estratégica para la conservacion del recurso hidrico dentro de
la jurisdiccion de CORPOCESAR, la cual sera el insumo principal para la priorizacién de areas. con
el fin de que se adquieran predios o se implemente la herramienta de pago por servicios
ambientales.

Que, en mérito de lo anteriormente expuesto,
RESUELVE:

ARTICULO PRIMERO: Adoptar la metodologia para la identificacion y delimitaciéon de areas de
Importancia estratégica para la conservacion del recurso hidrico dentro de la jurisdiccion de
CORPOCESAR, la cual se encuentra adjunta, el cual hace parte integral del presente acto
administrativo.

ARTICULO SEGUNDO: La Corporacién Auténoma Regional del Cesar - CORPOCESAR aplicara la
metodologia adoptada en el articulo anterior para la seleccién de los inmuebles en todos los
procesos de adquisicion de predios de importancia estratégica para la conservacion, recuperacion y
restauracion de los ecosistemas, la oferta natural y de interés hidrico para los Entes Territoriales y/o
para la implementacion del pago por servicios ambientales.

ARTICULO TERCERO: Que los Shapes Files que se generen en gjercicio de Identificacién y
Delimitacién de Areas de Importancia Estratégica para la Conservacién del Recurso Hidrico
(AECRH) para cada municipio, seran entregados a la Subdireccién de Planeacion y Sistemas de
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Informacién para efecto de que se integren al Sistema de Informacién Ambiental Territorial (SIAT) de
CORPOCESAR y hagan parte de la base de datos que se maneja en la Corporacion.

ARTICULO CUARTO: Comunicar el contenido de la presente resolucién a la Procuraduria Judicial
Agraria y Ambiental, a la Gobernacién del Cesar y a los municipios de la jurisdiccién de
CORPOCESAR, para su conocimiento y demas fines pertinentes.

ARTICULO QUINTO: El encabezamiento y la parte resolutiva de la presente Resolucién, deberan
ser publicados en el boletin y en la pagina WEB de la Corporacién.

ARTICULO SEXTO: Contra el presente acto administrativo no procede recurso alguno de

conformidad con lo previsto en el articulo 75 del Cédigo de Procedimiento Administrativo y de lo
Contencioso Administrativo

COMUNIQUESE, PUBLIQUESE Y CUMPLASE

YOLAND EZ MANJARREZ
Director General (E)

Elabord: Ing. Leuger Cortes Orduz / P.E Apoyo SIG Convenio Corpocesar- MADS-USAID- Chemonics Interna.
Revisé: Tima Martinez P.E— Subdireccién General del Area de Planeacion

Ménica Gonzalez P.E— Subdireccion General del Are_a de Planeacion
Aprob¢: Julic Fernandez Lascarro - Subdirector General del Area de Gestion Ambiental
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] METODOLOGIA PARA LA DELIMITACION DE ]
AREAS DE IMPORTANCIA ESTRATEGICA PARA LA CONSERVACION
DEL RECURSO HIDRICO (AECRH) EN JURISDICCION DE CORPOCESAR

Para delimitar cada area, se procedié mediante las herramientas hidrolégicas del software ArcGIS, {Hydrology). El cual
permite modelar de forma automatica un flujo de agua a través de un modelo de elevacién digital-DEM (ASTER GDEM
12.5m).

El primer paso fue recortar el DEM (raster) en ArcGIS 10.2.2, tomando como base el poligono Subzona Hidrografica para
cada municipio. Dentro del ArcToolbox encontramos las herramientas Extraction de Spatial Analyst, que permite recortar el
archivo raster; la ruta del procedimiento es el siguiente, ArcToolbox > Spatial Analyst Tools > Extraction > Extract by Mask,

(Fig. 1.).

‘Cabe resaltar que el DEM viene con un sistema de coordenada WGS84: por lo cual, se proyecté al Sistema de
coordenadas MAGNA Colombia Bogotd, sistema que se eligié para la modelacién de los datos; lo anterior se realizé a
través del siguiente recorrido: caja de herramientas ArcToolbox, Data Management Tools, Projections and
Transformations > Raster > Project Raster”

Posteriormente se utilizo la herramienta Fill; herramienta que permite rellenar vacios en la superficie del raster para quitar
imperfecciones en la informacion del DEM, (ArcToolbox > Spatial Analyst Tools > Hydrology > Fil]).

Luego se aplico la herramienta Flow Direction, esta herramienta crea un raster con la direccion de flujo de cada una de
sus celdas hasta su vecina cuesta abajo, Ia ruta fue la siguiente: ArcToolbox > Spatial Analyst Tools > Hydrology > Flow
Direction. “se toma como raster de entrada el generado con la herramienta fill realizado en el paso anterior’.

Seglin Puerta et al, (2013) la direccion del flujo (Flow Direction) es el primer paso en el analisis de superficies
hidrologicas; ya que todas las restantes herramientas hidroldgicas requieren de esta informacion para trabajar; Iz
herramienta Flow Direction encuentra la direccion del flujo para una celda comparando su valor de elevacion con los
valores de la elevacion de sus celdas vecinas. El resultado es un cédigo que identifica al vecino hacia donde el agua
fluira, (Fig. 1.).

Cl

Eigura No, 1.; Extract del DEM para la zona de estudio, generado en ArcGIS.

Jenson and Domingue (1988), referencia la Existencia de ocho direcciones de salida validas gue se relacionan con las
ocho celdas adyacentes hacia donde puede ir el flujo. Este enfoque cominmente se denomina el modelo de flujo de ocho
direcciones (D8).
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Eleavation surface

Direction coding

Eigura No. 2. ; Codificacién de la Direccidn de Flujo, Fuente: Puerta et al., (2013)

Seguidamente con la herramienta Flow Accumulation, se crea un raster del flujo acumulado para cada una de sus celdas,
esto quiere decir que se calcula para cada celda la cantidad de agua que fluye dentro de la celda desde todas las celdas
que drenan hacia ella, (Fig. 3. 6). Utilizando como entrada el raster generado en el paso anterior (Flow Direction).
“ArcToolbox > Spatial Analyst Tools > Hydrology > Flow Accumulation’.

ojojojojo|o
ol 11212]0
cl3]7|5]|]a]o
Ojojoj20]O]1
Ojojo|1l]2a]|0Q
Dlz2)|14]|7]|33] 2

Flow accumulation

Direction coding

Eigura No. 3. : Modelo de Acumulacion de Flujo, Fuente: Puerta et al., (207 3)

Para Finalizar se crea un nuevo shapefile tipo punto para obtener la cuenca, y se ubica en el punio de desembocadurz al
Rio; localizado en las coordenadas X - Y, luego se delimita la cuenca mediante la herramienta Watershed (ArcToolbox
>Spatial AnalystTool >Hydrology Watershed), ingresando como entrada el raster de direccion de flujo (Flow Direction),
mas el shapefile tipo punto (desembocadura). Por Gltimo, se convierte de raster a poligono (ArcToolbox >Conversion
Tools>From Raster> Raster to Polygon), para determinar el area de la cuenca, el perimetro y el caudal medio a través de
un Zonal Statistics Table posteriormente.

Adicionalmente el ejercicio de procesamiento digital anterior, podra adelantarse de ser necesario salidas 2 campo para
establecer puntos de control, (Levantamiento de Parcelas, Calitas, Georeferenciacidn entre otros), sumado a la utilizacion
de herramientas de sensoramiento remoto (drones) que puedan servir de apoyo para |la toma de la decisién pertinente.

ANEXO 1.
METODOLOGIA DE CALIFICACI_C')N COMPLEMENTARIOS PRIORIZACION
Y CALIFICACION A NIVEL DE PREDIAL
Para poder priorizar predios al interior del Area Delimitada para la Conservacién del Recurso Hidrico, se tienen que
establecer las corrientes hidricas de primer orden; Esta clasificacién se obtiene por medio del Método de
Strahler, el cual describe que un mismo rio y/o drenaje, puede tener segmentos de distinto orden a lo largo de
su curso, en funcion de los afluentes que llegan en cada tramo. El orden no se incrementa cuando a un
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segmento de un determinado orden confluye uno de orden menor, (Strahler, 19582). Esto hace referencia a
que se establece un orden de uno (1), a los drenajes o cauces sin tributarios, referenciandolos como un
drenaje hidrico o cauce de primer orden.

Puerta et al, (2013) implementa esta clasificacion a medida que los cauces aumentan cuando los cauces del mismo
orden se intersecan; por lo cual, la interseccién de dos vinculos de primer orden crearz un vinculo de segundo orden, la
interseccion de dos vinculos de segundo orden creara un vinculo de tercer orden, y asi sucesivamente. Sin embargo, la
interseccion de dos vinculos de distintos érdenes no aumentara el orden, (Fig. 4.).

Para poder identificar las corrientes de primer orden, el primer paso es la de clasificar las celdas con acumulacion de flujo
superior @ un umbral especificado denominadas como celdas pertenecientes a la red de flujo. El umbral debe ser
especificado como el nimero de celdas vertientes a la que se esta clasificando en cada momento. Se debe incorporar &l
valor que seria el mas indicado, ya que si el valor de acumulacion es muy bajo muchos pixeles seran seleccionados como
pertenecientes a la red hidrica, si por lo contrario, el valor del pixel es muy alto solo aquellos drenajes de orden alo
serian definidos como red hidrica. Esto quiere decir, que al seleccionar un valor bajo del umbral significa que
obtendremos afluentes pequefios en nuestra red de drenajes, en cambio un valor alto, modela los drenajes de mayor
tamano, (Puerta et al., 2013). Para generar la red de corrientes a partir del raster de acumulacién de flujo, creado en Iz
fase anterior (6.2.5.1. Fase 1), y se debe realizar de la siguiente manera: ArcToolbox > Spatial Analyst Tools > Map
Algebra > Raster Calculator; utilizando la formula Red_drenage= con (“FlowAcc_flow” > 100, 1).

Asimismo, se utilizé la herramienta Stream Link, la cual divide el cauce en segmentos no interrumpidos. Es decir, que
dichas secciones en las que se divide el recorrido del flujo seran segmentos que conectan dos uniones sucesivas, una
unién y un punto de desagie o una union y una division del area de drenaje; la ruta fue la siguiente ArcToolbox >Spatial
AnalystTool >Hydrology >Stream Link, (como raster de entrada se utilizé el generado en el punto anterior y el raster de
direccién de flujo).

Eigura No. 4. ; Clasificacién de Redes Método Strahler, Fuente: Puerta et al., (2013)

Posteriormente, se debe realizar la clasificacion el orden de las cuencas de acuerdo con el método de Strahler, utilizando
la herramienta “Stream Order”, mas el raster creado anteriormente (Stream Link) y el raster de direccién de flujo (Flow
Direction). El mapa de procedimiento fue el siguiente: ArcToolbox >Spatial Analyst Tool >Hydrology >Stream Order.
Seguidamente se utilizdé la herramienta “Stream to Feature”, para Crea un shapefile de drenajes con su respectivo
numero de nivel de orden dentro de la cuenca.Después, se debe utilizar la herramienta “Feature Vertice To Point”, con la
finalidad de obtener un punto al inicio de los drenajes de primer orden dentro de la cuenca, El procedimiento a realizar es
el el siguiente: se debe seleccionar los drenajes de primer orden y mediante la caja de herramientas ArcToolbox escoger
Data Management tolos >Feature >Feature Vertice to Point, (ftomando como opcidn gue la ubicacién del punto sez el
inicio del drenaje).

Seguidamente, al obtener el punto al inicio del drenaje, en la misma categoria de herramientas se debe seleccionar Add
XY Coordinates, para obtener las coordenadas X, Y para cada punto, con el fin de georreferenciar los puntos dentro de
la microcuenca.
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Una Vez identificadas la Microcuencas con mayor densidad de drenajes, se deben considerar los siguientes criterios:

Se debe Considerar los criterios de categoria y jerarquizacion las areas protegidas son esenciales para conservar |2
biodiversidad natural y cultural y los bienes y servicios ambientales que brindan son esenciales para la sociedad. El
decreto 2372 de 2010 Por el cual se reglamenta el Decreto-ley 2811 de 1974, |a Ley 99 de 1993, la Ley 165 de 1994 y el
Decreto- ley 216 de 2003, en relacion con el Sistema Nacional de Areas Protegidas, las categorias de manejo gue lo
conforman y se dictan otras disposiciones, las define en su articulo 2do como el Zrea definida.

De acuerdo con lo anterior, las areas protegidas con plan de manejo ambiental, las areas de importancia ecosistémica y
las areas de valor ambiental obtendran los siguientes puntajes en el proceso de priorizacién para compra de predios:
Matriz de calificacion criterio 1

Areas de importancia ecosistémica

Areas de paramo y subparamo 50 puntos
Humedales identificados o declarados 50 puntos
como reservas hidricas
Areas protegidas

Reserva Forestal Protectora 40 puntos
Areas de Manejo Especial 30 puntos
Distrito de Conservacion de Suelos 30 puntos
(cuando la

zonificacién indique area de preservacion,
conservacién o restauracion)

Distrito de Manejo Integrado (cuando la 30 puntos
zonificacién indique area de preservacion,
conservacion o restauracion)

Areas de importancia ambiental

Reserva Forestal Productora 20 puntos

Corredores de conservacion declarados y | 20 puntos

delimitados

Areas de amortiguacion de areas 10 punto
rotegidas

Dentro de las areas estratégicas identificadas, se procede con la evaluacion de factores de calificacion a nival predial,
y que determinaran el proceso final de viabilizarian técnica.

- Cantidad de acueductos abastecidos

Cantidad acueductos Puntaje obtenido
abastecidos
>1 15 puntos
1 10 puntos
0 0 puntos

Poblacion Abastecida:

Asociada al niUmero de habitantes benefician con la conservacién del predio, en funcién de
abastecimiento de la cantidad de usuarios cubiertos por los acueductos municipales, regionales o
distritales. Maximo puntaje a obtener: 10 puntos

| Poblacién beneficiada | Puntaje obtenido
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< a 50 habitantes 1 punto
Entre 50 y 150 habitantes 4 puntos
Entre 150 y 300 habitantes 6 puntos
> a 300 habitantes 10 puntos

- Presencia de Cuerpos Hidricos Asociado a la presencia o ausencia en el predio o como lindero de
corrientes hidricas, manantiales, afloramientos o nacimientos de agua. Méaximo puntaje a obtener: 10
puntos

Presencia de corrientes Puntaje obtenido
hidricas, manantiales,
afloramientos o
nacimientos de agua
Si > # Drenajes 10 puntos

No 0 puntos t

- Cobertura vegetal: Se evalla el porcentaje del area total del predio con cobertura vegetal de porte
herbaceo, arbustivo o arbdreo, diferente a cultivos transitorios (excluye plantaciones forestales de
especies exoticas y coberturas de especies invasoras). Su célculo se realiza en funcién del tipo de
cobertura en del predio. Maximo puntaje a obtener: 10 puntos.

Tipo de coberturay % | Puntaje obtenido
Cobertura de tipo arbéreo: cobertura vegetal de tipo boscoso, con alturas del
dosel superior a 5 metros.

Mayor al 50 % 10 puntos
Entre el 50% vy 30% 5 puntos
Menor al 30% 3 puntos

Cobertura de tipo arbustivo: cobertura vegetal de tipo arbustivo intervenido,
con evidencia de procesos sucesionales y alturas de copas entre los 2-5 metros.

Mayor al 50 % 5 puntos
Entre el 50% y 30% 3 puntos
Menor al 30% 2 puntos
Cobertura de herbaceo: coberturas vegetales de gramineas, manejadas o
nativas
Menor al 50% 2 puntos
Mayor al 50% 1 punto
]

- Grado de amenaza de los ecosistemas y coberturas naturales en el predio por presion
antrdpica. Se evalla en funcion de las actividades desarrolladas en las areas aledafas.

Grado de amenaza Puntaje obtenido
Predio cercano a desarrollos urbanos, industriales, de 10 puntos
infraestructura u otros de similar naturaleza
Predio colindante con desarrollo de actividades 7 puntos
agropecuarias
Predio colindante con desarrolio de actividades de 3 puntos
conservacion
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- CONFLICTO DE USO RESPECTO A POT- POMCA

Conflicto de uso Puntaje obtenido
Si 10 puntos
No 0 puntos

- Presencia Especies Amenazadas o Vedadas de Flora y/o fauna

Presencia Puntaje obtenido
Si 10 puntos
| No 0 puntos

- Conectividad Ecosistémica: Analisis del entorno con el fin de determinar si la intervencion del

predio (compra- reforestacion- recuperacion) contribuye a la recuperacion funcional o estructural de
un ecosistema general.

Conectividad Ecosistémica Puntaje obtenido
Si 10 puntos
No 0 puntos

La pricrizacion de predios, incluidos dentro de las areas estratégicas definidas, se realiza de acuerdo a |z siguiente

escala de puntaje acumulado (sumatoria de factores), determinando de esta manera |z prioridad de intervencion
(compra, mantenimiento).

CALIFICACION PREDIO
Prioridad de Intervencién Puntaje Total
Alta 60 — 85 puntos
Media 40 - 59 puntos
Baja < 39 puntos

Adicionalmente a la calificacion de los anteriores factores, se debe considerar como INFORMACION DE CONTROL,

verificar que la adquisicion o mantenimiento del predio no se encuentre como obligacién de un particular, dentro de
tramites permisivos o sancionatorios.

Elabord: Ing. Leuger Cortes Orduz / P.E Apoyo SIG Convenio Corpocesar- MADS-USAID- Chemonics Interna.
Revisé: Tima Martinez P.E—~ Subdireccion General del Area de Planeacion

Manica Gonzélez P.E- Subdireccion General del Area de Planeacién
Aprobd: Julio Fernandez Lascarro - Subdirector General del Area de Gestién Ambiental
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